Contents

2 TESTO 6610 PROBE ................................................................................................. 97
  2.1 Specifications..................................................................................................... 97
      2.1.1 Functions and use.................................................................................... 97
      2.1.2 Design of the probe............................................................................... 99
      2.1.3 Accessories............................................................................................ 100
  2.2 Product description .......................................................................................... 100
      2.2.1 Overview of probe and filter types ...................................................... 100
      2.2.2 testo 6611 wall probe ......................................................................... 104
      2.2.3 testo 6612 duct probe .......................................................................... 107
      2.2.4 testo 6613 cable probe ........................................................................... 111
      2.2.5 testo 6614 heated cable probe ............................................................ 115
      2.2.6 testo 6615 trace humidity cable probe (self-adjustment) .................. 118
      2.2.7 testo 6617 cable probe (self-monitoring) .......................................... 122
  2.3 Commissioning ............................................................................................... 126
      2.3.1 Installing the probe................................................................................ 126
      2.3.2 Connecting/removing the probe to/from the transmitter ................. 130
  2.4 Maintenance and cleaning .............................................................................. 131
      2.4.1 Replacing filters/protection caps ......................................................... 131
      2.4.2 Cleaning the instrument and filter/protection cap ......................... 134
      2.4.3 Replacing the sensor.............................................................................. 134

3 PARAMETERIZING, ADJUSTING AND ANALYZING SOFTWARE (P2A SOFTWARE)
.......................................................................................................................... 135
  3.1 Specifications..................................................................................................... 135
      3.1.1 Functions and use.................................................................................. 135
      3.1.2 System requirements........................................................................... 136
      3.1.3 Scope of delivery.................................................................................. 137
  3.2 First steps ......................................................................................................... 137
      3.2.1 Installing the software/driver ............................................................... 137
      3.2.2 Starting the software .......................................................................... 138
  3.3 Using the software .......................................................................................... 139
      3.3.1 User interface......................................................................................... 139
      3.3.2 Editing instrument/parameter file ....................................................... 141
      3.3.3 Analyzing/testing the transmitter ....................................................... 150
      3.3.4 Adjusting the transmitter ................................................................... 155
      3.3.5 Transmitter history.............................................................................. 160
4 TIPS AND ASSISTANCE ........................................................................................................ 166
4.1 Questions and answers .................................................................................................... 166
4.2 Accessories and spare parts ........................................................................................... 167
   4.2.1 Ordering options for testo 6681 transmitter (0555 6681) ....................................... 169
   4.2.2 Ordering options for testo 6610 probes (0555 6610) .............................................. 172
2 testo 6610 probe

2.1 Specifications

2.1.1 Functions and use

The plug-in, adjusted probes from the testo 6610 range are used in conjunction with the testo 6681 humidity transmitter.

These measuring units are suitable for the following applications, for example:

- Process instrumentation
- Clean rooms
- Test benches
- Drying processes
- Production and storage air quality
- Complex room climate applications.

2.1.1.1 Digital probes:

The probes are adjusted in the factory and transmit their adjustment data to the internal memory of the testo 6681 transmitter. The information is transmitted between the probe and transmitter in a purely digital form. The probes can therefore be disconnected from the transmitter for adjustment or servicing while the transmitter itself can remain at the measuring point.

Hint:

We recommend in this case that a probe of the same type be inserted into the transmitter immediately in order to be able to continue measuring with minimal interruption.

The transmitter identifies the probe and records that a probe was connected in the history.

The testo 6681 transmitter cannot be run with the testo 6600 probes; testo 6610 probes must be used.
2.1.1.2 The Testo humidity sensor

With the Testo humidity sensor, which has been in successful use and continually improved for more than twenty years, the focus has from the very beginning been on both accuracy parameters, namely measuring uncertainty and long-term stability.

The capacitive humidity sensor is in principle a plate capacitor consisting of two electrically conductive plates (electrodes (1) and (2), see diagram below) opposite each other.

A humidity-sensitive polymer (5) serves as the dielectric. The special feature lies in the perfect way the individual layers are matched to each other. This is evident particularly in the top electrode, which has to perform two tasks that, at first glance, appear contradictory: it must be completely permeable to the water vapour that is to be fed into the polymer dielectric, but at the same time it must be impervious, smooth and repellent to condensate, oil and dirt in order to protect the sensor.

The humidity sensor cannot be exchanged by the customer.
The humidity sensor may not be damaged or touched. Contamination and damage lead to an impairment of the measurement and the measuring accuracy.

2.1.1.3 Self-diagnosis

The probes in the testo 6610 range monitor their functionality themselves and report the following faults:

- Sensor breaks
- Sensor short-circuit
Condensation
The condensation message is issued at a reading of 100 % RH and deactivated once the readings are within the valid range.

Error message with drift at the adjustment points
Value for relative humidity less than 0 % RH.
The trigger threshold is set at -2 % RH. This means that an error message is only issued once a clear effect is discernible.

Early warning when sensor corrosion is starting to develop
The testo 6617 probe is able to signal the first signs of corrosion. The probe can thus be changed at an early stage without interrupting the machine availability.

Self-adjustment (testo 6615 only)

Excess temperature
Error message if the permissible process temperature is exceeded

2.1.2 Design of the probe
The probes of the testo 6610 range are made up of the following components (included in delivery):

- Probe connector
- Probe shaft with protection cap and sensors (% RH and °C or °F)
- Mounting bracket (for testo 6612 duct version)
- Probe cable (testo 6612 to 6617 duct and cable version), bend radius minimum Ø 50 mm
2.1.3 Accessories

The following accessories are available for probes in the testo 6610 range:

- Filters and protection caps (see chapter 2.2.1.4, Filters)
- Calibration certificates according to ISO and DAkkS (see chapter 4.2, Accessories and spare parts).

2.2 Product description

2.2.1 Overview of probe and filter types

2.2.1.1 Probe version

A detailed description of the probe versions can be found from chapter 2.2.2 onwards.

The following probe versions are available for the testo 6681 humidity transmitter:

<table>
<thead>
<tr>
<th>Version</th>
<th>Article no.</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>testo 6611 0555 6610-L11</td>
<td>Wall probe version; accuracy to ± 1 % RH; temperature range -20 °C to +70 °C/-4 to +158 °F</td>
<td></td>
</tr>
<tr>
<td>testo 6612 0555 6610-L12</td>
<td>Duct probe version; accuracy to ± 1 % RH; temperature range -30 °C to +150 °C/-22 to +302 °F</td>
<td></td>
</tr>
<tr>
<td>testo 6613 0555 6610-L13</td>
<td>Cable probe version; accuracy to ± 1 % RH; temperature range -70 °C to +180 °C/-94 to +356 °F</td>
<td></td>
</tr>
<tr>
<td>testo 6614 0555 6610-L14</td>
<td>Heated cable probe version; accuracy to ± 1 % RH; temperature range -40 °C to +180 °C/-40 to +356 °F</td>
<td></td>
</tr>
<tr>
<td>testo 6615 0555 6610-L15</td>
<td>Trace humidity cable probe version; dew point to -60°Ctd; temperature range -40 °C to +120 °C/-40 to +248 °F</td>
<td></td>
</tr>
<tr>
<td>testo 6617 0555 6610-L17</td>
<td>Cable with cover electrode monitoring probe version; accuracy ± 1.2 % RH; temperature range -40 °C to +180 °C/-40 to +356 °F</td>
<td></td>
</tr>
</tbody>
</table>

2.2.1.2 Determining the accuracy/measuring uncertainty

The entries for the measuring uncertainty for the probe are determined in accordance with GUM (Guide to the Expression of Uncertainty in Measurement/DIN V ENV 13005). All parts that make up the measuring
uncertainty given by Testo are listed below. When comparing the measuring uncertainty/accuracy between manufacturers, which components are included is to be taken into account. In many cases, not all elements that contribute to measuring uncertainty are assessed, for example if the error contribution of the production adjustment is shown separately or not at all.

The measuring uncertainty of the probe includes the sensor and its electronics as well as the output of the digital measuring signal:

1. **Linearity including scatter**
   Systematic error and scattering of the components (due to manufacturing tolerances)

2. **Hysteresis**
   Hysteresis indicates the maximum deviation of the readings that are obtained when you set the same value for the parameter, once coming from a smaller value, once coming from a larger value (humidity sensors actually have no hysteresis, but rather very slow adjustment effects that appear to be hysteresis when considered only for a short period.)

3. **Reproducibility**
   Repeatability (scattering of the readings in the event of the same parameter being entered successively)

4. **Production adjustment area**
   The measuring uncertainty of the reference instruments of the adjustment area (including the reference instrument) in production

5. **Uncertainty of the testing**
   Uncertainty of the procedure for determining points 1 and 2.
### 2.2.1.3 Ordering options for testo 6610 probes (0555 6610)

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lxx Probe type</strong></td>
<td></td>
</tr>
<tr>
<td>L 11</td>
<td>Probe 6611</td>
</tr>
<tr>
<td>L 12</td>
<td>Probe 6612</td>
</tr>
<tr>
<td>L 13</td>
<td>Probe 6613</td>
</tr>
<tr>
<td>L 14</td>
<td>Probe 6614</td>
</tr>
<tr>
<td>L 15</td>
<td>Probe 6615</td>
</tr>
<tr>
<td>L 17</td>
<td>Probe 6617</td>
</tr>
<tr>
<td><strong>Mxx Protective filter</strong></td>
<td></td>
</tr>
<tr>
<td>M 01</td>
<td>Stainless steel sintered filter</td>
</tr>
<tr>
<td>M 02</td>
<td>Metal wire protection cap</td>
</tr>
<tr>
<td>M 03</td>
<td>Sintered PTFE filter</td>
</tr>
<tr>
<td>M 04</td>
<td>Open metal protection cap</td>
</tr>
<tr>
<td>M 05</td>
<td>ABS plastic cap (open)</td>
</tr>
<tr>
<td>M 06</td>
<td>PTFE filter with drip hole</td>
</tr>
<tr>
<td>M 07</td>
<td>PTFE filter with drip hole and condensation protector</td>
</tr>
<tr>
<td>M 08</td>
<td>Filter for $\text{H}_2\text{O}_2$ atmospheres</td>
</tr>
<tr>
<td><strong>Nxx Cable length</strong></td>
<td></td>
</tr>
<tr>
<td>N 00</td>
<td>Without cable (testo 6611)</td>
</tr>
<tr>
<td>N 01</td>
<td>1 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 02</td>
<td>2 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 05</td>
<td>5 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 10</td>
<td>10 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td><strong>Pxx Probe length</strong></td>
<td></td>
</tr>
<tr>
<td>P 07</td>
<td>Probe length approx. 70 mm (testo 6611)</td>
</tr>
<tr>
<td>P 12</td>
<td>Probe length approx. 120 mm (testo 6613)</td>
</tr>
<tr>
<td>P 20</td>
<td>Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>P 30</td>
<td>Probe length approx. 300 mm (testo 6612, 6613, 6614)</td>
</tr>
<tr>
<td>P 50</td>
<td>Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>P 80</td>
<td>Probe length approx. 800 mm (testo 6612, 6613)</td>
</tr>
</tbody>
</table>
2.2.1.4 Filters

One of the following filters or protection caps can be used for each probe version:

<table>
<thead>
<tr>
<th>Filter*</th>
<th>Article no.**</th>
<th>Characteristic</th>
<th>Length A (mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M 01</td>
<td>0554 0647</td>
<td>Stainless steel sintered filter</td>
<td>33</td>
</tr>
<tr>
<td>M 02</td>
<td>0554 0757</td>
<td>Metal wire protection cap</td>
<td>40.3</td>
</tr>
<tr>
<td>M 03</td>
<td>0554 0759</td>
<td>Sintered PTFE filter</td>
<td>35</td>
</tr>
<tr>
<td>M 04</td>
<td>0554 0755</td>
<td>Open metal protection cap</td>
<td>35</td>
</tr>
<tr>
<td>M 05</td>
<td>0192 0265</td>
<td>Open ABS plastic cap</td>
<td>25</td>
</tr>
<tr>
<td>M 06</td>
<td>0554 9913</td>
<td>PTFE filter with drip hole</td>
<td>35</td>
</tr>
<tr>
<td>M 07</td>
<td>0554 9913 + 0554 0166</td>
<td>PTFE filter with drip hole and condensation protector</td>
<td>35 55</td>
</tr>
<tr>
<td>M 08</td>
<td>0554 6000</td>
<td>Filter for H₂O₂ atmospheres</td>
<td>35</td>
</tr>
</tbody>
</table>

* When ordering the probe, please use this filter code, cf. chapter 2.2.1.3, Ordering options for testo 6610 probes (0555 6610).

** When purchasing a replacement (filters only), please use this order number...
2.2.2 testo 6611 wall probe

The wireless testo 6611 probe is inserted into the testo 6681 humidity transmitter that is mounted on the wall and ready-wired.

At a glance

1. Filter (including: humidity and temperature sensor)
2. Probe shaft
3. Key
4. Connector

Application

Monitoring and regulating the production and storage air quality when manufacturing and storing hygroscopic products

Meeting the top accuracy requirements

Clean room applications for which a metal housing is required.
Technical Data

Parameters
Humidity (% RH°/°Ctd/°Ftd), etc.
Temperature

Measuring range
Humidity: 0 to 100 % RH
Temperature: -20 to 70 °C/-4 to +158 °F

Material
Probe shaft: Stainless steel
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*
Length 200 mm
Humidity
± (1.0 % RH + 0.007 x reading) for 0 to 90 % RH
± (1.4 % RH + 0.007 x reading) for 90 to 100 % RH
0.02 % RH/K, dependent upon the process temperature (with a deviation of 25 °C/+77 °F)
0.02 % RH/K, dependent upon the electronics temperature (with a deviation of 25 °C/+77 °F)
Temperature
±0.15 °C (0.27 °F)
with slope PT1000 class AA
* Refer to the charts below for the correlation between temperature and accuracy.

Length 70 mm
As with length of 200 mm, but with additional measuring error, specified for the operating mode 2 channels at 12 mA, without display light, relay off:
Humidity: ±1.6 % RH (additional)
Temperature: ±0.6 °C (1.1 °F)
in addition

Reproducibility
Better than ±0.2 % RH

Sensor
Response time without protective filter: t 90 max. 15 sec.

Probe dimensions
Diameter of probe shaft: 12 mm
E = 55 mm
L = approx. 70 mm or 200 mm
L – A = 35 mm or 165 mm
A, see Table Filters, chapter 2.2.1.4

1 For constant use in high humidity (> 80% rF at ≤ 30°C for > 12 h, > 60% rF at > 30°C for > 12 h), please contact us via www.testo.com/service-contact
Measuring accuracy of testo 6611 wall probe

Humidity error according to amount $|\pm \% \text{RH}|$ as a factor of process humidity

Temperature error as a factor of process temperature and temperature of electronics
2.2.3 testo 6612 duct probe

The testo 6612 probe measures the humidity and temperature in air ducts.

At a glance

In the event of overpressures, the probe may become a projectile.

For assembly, see **Pressure resistance** on the following page.

Application

Monitoring and regulating the production and storage air quality in air ducts when manufacturing and storing hygroscopic products.
Meeting the top accuracy requirements
Air duct applications for which a metal housing is required.

**testo 6610-2.2 Product description**

![testo 6681 transmitter and testo 6612 duct probe](image)

### Technical Data

**Parameters**

- **Humidity**: (% RH/°Ctd/°Ftd), etc.
- **Temperature**

**Measuring range**

- **Humidity**: 0 to 100 % RH
- **Temperature**: -30 to +150 °C/-22 to +302 °F

**Material**

- **Probe shaft**: Stainless steel
- **Line**: Sheathed, FEP
- **Connector**: ABS plastic

**Accuracy (at 25°C/77°F)**

- **Humidity**: ± (1.0 % RH + 0.007 x reading) for 0 to 90 % RH
- **Humidity**: ± (1.4 % RH + 0.007 x reading) for 90 to 100 % RH

- **Temperature**: ±0.15 °C (0.27 °F)
- **Slope**: PT1000 class AA

0.02 % RH/K, dependent upon the process temperature (with a deviation of 25 °C/+77 °F)
0.02 % RH/K, dependent upon the electronics temperature (with a deviation of 25 °C/+77 °F)

**Reproducibility**

Better than ±0.2 % RH

**Sensor**

Response time without protective filter: t 90 max. 15 sec.

---

2 For constant use in high humidity (> 80% rF at ≤ 30°C for > 12 h, > 60% rF at > 30°C for > 12 h), please contact us via www.testo.com/service-contact
**Probe dimensions**
Diameter of probe shaft: 12 mm
L = approx. 200/300/500/800 mm
L – A = 165/265/465/765 mm
A, see Table Filters, chapter 2.2.1.4, page 103.

**Cable length incl. probe shaft and filter**

**Customized for duct version**

**Pressure resistance**
PN 10 (probe tip)**
** If installing probe under pressure, please use cutting ring screw connection (order no. 0554 1795).

**Measuring accuracy of testo 6612 duct probe**

Humidity error according to amount |±% RH| as a factor of process humidity

![Graph showing humidity error for different % RH values |±|0.5, 1.0, 1.5, 2.0, 2.5, 3.0% RH| as a factor of process humidity | 6611, 6612, 6613, 6622, 6623]
Temperature error as a factor of process temperature and temperature of electronics

The diagram illustrates the temperature error for different conditions. The curves represent the system error with and without the probe, and the error ranges from -25 °C to +70 °C and -13 °F to +158 °F.
2.2.4 testo 6613 cable probe

The testo 6613 probe is used when the spatial separation of the transmitter and probe is required.

At a glance

![Diagram of testo 6613 cable probe with labels: 1 Connector, 2 Key, 3 Probe cable, 4 Probe shaft, 5 Filter (including: humidity and temperature sensor).]

In the event of overpressures, the probe may become a projectile.

For assembly, see **Pressure resistance** on the following page.

Application

- Monitoring and regulating industrial humidity processes (apart from high-humidity processes), e.g. food production, storing fruit
- Monitoring the production and storage air quality when manufacturing and storing hygroscopic products
- Meeting the top accuracy requirements
- Clean room applications
- Applications for which a sturdy metal housing is required.
We recommend that the testo 6614 (heated) probe be used for continuous high-humidity processes.

Technical Data

Parameters

Humidity (% RH/°Ctd/°Ftd), etc.
Temperature

Measuring range

Humidity: 0 to 100 % RH
Temperature: -70 to +180°C/-94 to +356 °F

Material

Probe shaft: Stainless steel
Line: Sheathed, FEP
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*

Humidity
0.02 % RH/K, dependent upon the process temperature
(with a deviation of 25 °C/+77 °F)
0.02 % RH/K, dependent upon the electronics temperature
(with a deviation of 25 °C/+77 °F)
Temperature
±0.15 °C (0.27 °F)
Slope PT1000 class AA

* Refer to the charts below for the correlation between temperature and accuracy.

Reproducibility
Better than ±0.2 % RH

Sensor
Response time without protective filter: t 90 max. 15 sec.

For constant use in high humidity (> 80% rF at ≤ 30°C for > 12 h, > 60% rF at > 30°C for > 12 h), please contact us via www.testo.com/service-contact
**Probe dimensions**

Diameter of probe shaft: 12 mm  
L = approx. 120/200/300/500/800 mm  
L – A = 85/165/265/465/765 mm  
A, see Table Filters, chapter 2.2.1.4.

**Probe length incl. probe shaft and filter**

1/2/5/10 m

**Pressure resistance**

PN 10 (probe tip)  
PN 1 (if end of probe/cable is involved in process)

** If installing probe under pressure, please use cutting ring screw connection (order no. 0554 1795).

**Measuring accuracy of testo 6613 cable probe**

Humidity error according to amount \[\pm \% \text{RH}\] as a factor of process humidity
Temperature error as a factor of process temperature and temperature of electronics

- System error 6681 + probe, electronics 25 °C/77 °F
- System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
2.2.5 testo 6614 heated cable probe

The testo 6614 heatable probe is suitable for use in high-humidity processes in which there is the possibility of condensation for the probe.

Please also see volume 1, chapter 1.3.3.5 for the functional principle of the testo 6614.

At a glance

In the event of overpressures, the probe may become a projectile.

For assembly, see Pressure resistance on the following page.

Application

Monitoring and regulating high-humidity processes, e.g. drying (ceramics, tobacco, wood, food) and maturing (cheese, fruit).

At flow velocities > 1 m/s, an additional measuring uncertainty, not higher than +1.5 % RH, is to be expected. To prevent this error and ensure
the highest measuring accuracy: Use condensation protector 0554 0166.

Technical Data

Parameters
Humidity (% RH/°Ctd/°Ftd), etc.
Temperature

Measuring range
Humidity: 0 to 100 % RH
Temperature: -40 to +180 °C/-40 to +356 °F

Material
Probe shaft: Stainless steel
Line: Sheathed, FEP
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*
Humidity (values valid when used with Condensation protector 0554 0166)
± (1.0 % RH + 0.007 x reading) for 0 to 100 % RH
0.02 % RH/K, dependent upon the process temperature (with a deviation of 25 °C/+77 °F)
0.02 % RH/K, dependent upon the electronics temperature (with a deviation of 25 °C/+77 °F)

Temperature
±0.15 °C (0.27 °F)
Slope PT1000 class AA

Reproducibility
Better than ±0.2 % RH

Sensor
Response time without protective filter: t 90 max. 15 sec.

Probe dimensions
Diameter of probe shaft: 12 mm
Diameter of temp. probe: 3 mm
L = approx. 200/500 mm
L – A = 165/465 mm
A, see Table Filters, chapter 2.2.1.4.

Probe length incl. probe shaft and filter
1/2/5/10 m
Pressure resistance**
PN 10 (probe tip)
PN 1 (if end of probe/cable is involved in process)

** If installing probe under pressure, please use cutting ring screw connection (order no. 0554 1795).

Measuring accuracy of heated testo 6614 cable probe

Humidity error according to amount |±% RH| as a factor of process humidity

Temperature error as a factor of process temperature and temperature of electronics

System error 6681 + probe, electronics 25 °C+77 °F
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
2.2.6 testo 6615 trace humidity cable probe (self-adjustment)

The testo 6615 probe corrects deviations in measurements by means of self-adjustment. This has a particular significance with low humidity values (in dewpoint range).

Please also see volume 1, chapter 1.3.3.6 for the functional principle of the testo 6615.

Only use testo 6615 with sintered PTFE filter (art. no. 0554 0759) or sintered stainless steel filter (art. no. 0554 0647).

During the self-adjustment phase the signal values of the analog outputs remain on hold, meaning they are frozen for the duration.

At a glance

In the event of overpressures, the probe may become a projectile.

For assembly, see Pressure resistance on the following page.
Application

Monitoring and regulating trace humidity processes (compressed air with adsorption or membrane driers and plastic granulate driers)

Used when spatial separation of transmitter and probe is required.

testo 6681 transmitter  
testo 6615 trace humidity cable probe

Technical Data

Parameters

Dewpoint (°Ctd/°Ftd), etc.
Temperature

Measuring range

Dewpoint: - 60 to + 30 °Ctd/-148 to +212 °Ftd
Temperature: - 40 to +120 °C, -40 to +248 °F
(Temp. durability up to +180 °C/+356 °F)

Material

Probe shaft: Stainless steel
Line: Sheathed, FEP
Connector: ABS plastic

Accuracy (at 25 °C/77 °F)*

Dewpoint
± 1 K bei 0 °Ctd/+32 °Ftd
± 2 K bei -40 °Ctd/- 40 °Ftd
± 4 K bei -50 °Ctd/-58 °Ftd
± 6 K bei -60 °Ctd/-76 °Ftd

Dependency on process temperature (Deviation from 25 °C/77 °F)
± 0,1 Ktf/K at -40 °C...25 °C/ -40 °F...+77 °F
± 0,2 Ktf/K at 25 °C...50 °C/ 77 °F...+122 °F
- ± 0,4 Ktf/K at 50 °C...120 °C/ +122 ° F...+248 °F

Temperature
±0.15 °C (0.27 °F)
Slope PT100 class AA

* Refer to the charts below for the correlation between temperature and accuracy.
Reproducibility
Better than ±0,2 % RH

Sensor
Response time without protective filter: t 90 max. 15 sec.

Probe dimensions
Diameter of probe shaft: 12 mm
L = approx. 200/500 mm
L – A = 165/465 mm
A, see Table Filters, chapter 2.2.1.4.

Cable length incl. probe shaft and filter
1/2/5/10 m

Pressure resistance
PN 16 (probe tip)**
** If installing probe under pressure, please use cutting ring screw connection (order no. 0554 1795).

Measuring accuracy of testo 6615 trace humidity cable probe
Dewpoint error numerically |±%RH| dependent on the process dewpoint
Temperature error as a factor of process temperature and temperature of electronics

![Graph showing temperature error as a factor of process temperature and temperature of electronics.](image-url)
2.2.7 testo 6617 cable probe (self-monitoring)

The testo 6617 probe is used if spatial separation of the transmitter and probe is required, particularly for media (gases, vapours) which can jeopardize/damage the humidity sensor (the testo 6617 has a self-monitoring and early-warning function for such applications).

At a glance

1 Stecker
2 Taste
3 Fühlerkabel
4 Sondenrohr
5 Filter (darunter: Feuchte- und Temperatursensor)

In the event of overpressures, the probe may become a projectile.

For assembly, see Pressure resistance on the following page.
Application

Monitoring and regulating industrial humidity processes involving corrosive media (apart from high-humidity processes) with the exception of applications with HCL, HF and other acids and acidifiers in larger concentrations (SO$_2$, SO$_3$, NO$_2$)

Meeting the top accuracy requirements

Applications for which a sturdy metal housing is required.

This probe does NOT have a longer life with exposure to aggressive media than the testo 6613, for example. However, early warning of damage to the sensor is given so that machine failures can be avoided.

2.2.7.1 Self-monitoring of cover electrode

Use in harsh ambient conditions with aggressive media in some cases incurs the risk of damage to the sensor.

Damage to the sensor is generally reflected by incorrect readings which occur a long time before the sensor is wrecked. If this damage to the sensor is not spotted until too late, high costs can be incurred due to unusable readings or machine shutdowns and waiting times until the sensor is replaced.

The testo 6617 has a unique self-monitoring function. This allows early detection of damage to the sensor, e.g.:

- Mechanical damage (e.g. scratches)
- Damage from aggressive gases (e.g. acids in aerosol form)
- Welling or detachment of polymer layer due to effects of solvents.

![Diagram of sensor components](image)

1. Cover electrode
2. Bottom electrode
3. Substrate (Ceramic substrate for mechanical protection)
4. Connections (protected against corrosion)
5. Dielectric layer
Once the self-monitoring reaches the specific limit value, the probe warning message "Sensor early warning" is issued.

**Technical Data**

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity (%) RH/°Ctd/°Ftd</td>
<td>0 to 100 % RH⁴</td>
</tr>
<tr>
<td>Temperature</td>
<td>-40 to +180 °C/-40 to +356 °F</td>
</tr>
</tbody>
</table>

**Measuring range**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity (%) RH/°Ctd/°Ftd</td>
<td>0 to 100 % RH⁴</td>
</tr>
<tr>
<td>Temperature</td>
<td>-40 to +180 °C/-40 to +356 °F</td>
</tr>
</tbody>
</table>

**Material, weight**

- Probe shaft: Stainless steel
- Line: Sheathed, FEP
- Connector: ABS plastic

**Accuracy (at 25 °C/77 °F)***

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Accuracy Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td>± (1.2 % RH + 0.007 x reading) for 0 to 90 % RH</td>
</tr>
<tr>
<td></td>
<td>± (1.6 % RH + 0.007 x reading) for 90 to 100 % RH</td>
</tr>
</tbody>
</table>

⁴ For constant use in high humidity (> 80% rF at ≤ 30°C for > 12 h, > 60% rF at > 30°C for > 12 h), please contact us via www.testo.com/service-contact

**Reproducibility**

Better than ±0,2 % RH

**Sensor**

Response time without protective filter: t 90 max. 15 sec.

**Probe dimensions**

Diameter of probe shaft: 12 mm
L = approx. 200/500 mm
L – A = 165/465 mm
A, see Table Filters, chapter 2.2.1.4.
Probe length incl. probe shaft and filter
1/2/5/10 m

Pressure resistance

Measuring accuracy of testo 6617 cable probe (self-monitoring)

Humidity error according to amount $|\pm \%\text{RH}|$ as a factor of process humidity

![Humidity graph](image)

Temperature error as a factor of process temperature and temperature of electronics

![Temperature graph](image)

PN 10 (probe tip)**

** If installing probe under pressure, please use cutting ring screw connection (order no. 0554 1795).
2.3 Commissioning

2.3.1 Installing the probe

2.3.1.1 Installing the testo 6611 wall probe
The testo 6611 probe (wall version) simply has to be inserted into the socket of the testo 6681 transmitter.

2.3.1.2 Installing the testo 6612 duct probe
A description of the duct mounting of the testo 6612 probe can be found in volume 1, chapter 1.3.2.2.

2.3.1.3 Installing testo 6613/6614/6615/6617 probes
If used with these probes, the testo 6681 transmitter is mounted on the wall, see volume 1, chapter 1.3.2.1 Commissioning.

Install probe according to the application and the measuring and spatial conditions, cf. cases A1 to C below

In processes with which condensate forms at the humidity probe, install the probe vertically (filter points downwards).

A 1 Wall mounting of probe

![Wall mounting of probe diagram]

Wall/duct holder
Order no. 0554 6651
A 2  Wall mounting of testo 6614 heated probe

When mounting the testo 6614 heated probe version, the temperature probe must be secured as close to the humidity probe as possible (max. 10 cm). An appropriate assembly tool is supplied with the testo 6614.

![Diagram showing wall mounting of testo 6614 heated probe]

- **Wall/duct holder**
  Order no. 0554 6651

- **testo 6614**

- **Temperature probe**

- **Distance of probe tips of humidity probe - temperature probe**: As close as possible, but without touching (Distance between probe tips max. 10 cm)

- **Assembly tool, supplied with wall/duct holder**
  Order no. 0554 6651
B 1 Duct mounting of probe

Engage transmitter in the holder on the end of the duct probe

Hole Ø 12.5 mm

Wall/duct holder
Order no. 0554 6651

Only atmospheric processes up to approx. 1 bar positive pressure. Alternatively, the single-hole duct holder (order no. 0554 1793) can also be used.
B 2 Duct mounting of testo 6614 heated probe

When mounting the testo 6614 heated probe version, the temperature probe must also be secured at a distance of approximately 10 cm from the humidity probe. An appropriate assembly tool is supplied with the testo 6614.

C Process mounting

During installation, ensure that the probe cannot be damaged during operation.

For the testo 6614 (heated probe version), please use the cutting ring screw connection, order no. 0400 6193, to assemble the temperature probe.
2.3.2 Connecting/removing the probe to/from the transmitter

- Insert probe connector into socket of testo 6681 until it engages. The testo 6681 identifies which probe is connected.
- To remove the probe, the lock release button on the probe must be pressed so that this can be removed.
2.4 Maintenance and cleaning

2.4.1 Replacing filters/protection caps

2.4.1.1 Replacing the filter/protection cap for testo 6611 wall version

Do not damage the sensors when exchanging the filter/the protection cap and do not touch their surfaces!

1. Unscrew defective filter/protection cap (2) from probe shaft (1).
2. Screw new filter/protection cap onto probe shaft.

Screw on protection cap by hand, i.e. do not tighten it using a tool.
2.4.1.2 Replacing the filter/protection cap for testo 6612 duct version

Do not damage the sensors when exchanging the filter/the protection cap and do not touch their surfaces!

Hint:
Mark the insertion length of the probe shaft near the screw (9).

1. Undo screw (9) and pull shaft probe (7) together with filter/protection cap (8) from the wall/duct holder (5).

2. Unscrew defective filter/protection cap from probe shaft and screw on new filter/protection cap.

   Screw on protection cap by hand, i.e. do not tighten it using a tool.

3. Replace O-ring (6) if necessary. Push probe shaft into duct as far as the marking and fix position with screw (9).
2.4.1.3 Replacing the filter/protection cap for cable versions

The following descriptions applies to these probes:

- testo 6613
- testo 6614
- testo 6615
- testo 6617

Do not damage the sensor when exchanging the filter/the protection cap and do not touch its surface!

1. Unscrew defective filter/protection cap (2) from probe shaft (1).
2. Screw new filter/protection cap onto probe shaft.
Screw on protection cap by hand, i.e. do not tighten it using a tool.

2.4.2 Cleaning the instrument and filter/protection cap

Only clean the instrument carefully with a moist cloth.
Do not use aggressive cleaning agents.
Do not use any solvents.
Unscrew cap or protection cap to clean, clean with compressed air and replace. Take care not to damage the sensor!

2.4.3 Replacing the sensor

Thanks to the probe concept (digital, plug-in), all probes can be changed in situ within seconds if necessary, generally without any interruption to the operation of the machine.

To maintain the extremely high accuracy of the testo 6610 probe, customers are not able to replace the sensor.

Please contact your Testo Service team for this.
3 Parameterizing, adjusting and analyzing software (P2A software)

3.1 Specifications

The P2A software is used for the parameterizing, adjustment and analysis of testo transmitters. The following applies:

- Generally, all testo transmitters (as of 2007) are supported.
- For each newly purchased Testo transmitter, a free software upgrade must be installed possibly, containing the instrument drivers for all transmitters which are connectable at that time.
- This upgrade can be downloaded free of charge at any time from the Testo homepage www.testo.com/download-center (requires registration).

The software must only be bought one time, even for owners of several testo transmitters.

3.1.1 Functions and use

In the P2A software, two different file types are used: The instrument and the parameter file.

**Instrument file**

The parameters of a particular transmitter are stored in its so-called instrument file. Using this file, the parameters can be edited and the instrument can be tested and adjusted.

Instrument files also contain the respective histories in addition to the parameter data, i.e. "log books" are kept for the previous parameterizations, adjustments and messages (see chapter 3.3.5).

Instrument files are ".cfm" format files.
Parameter file
Parameter files are not tied to a specific individual transmitter and contain only parameter data/no history data.

If you use various instruments of the same type, you can create parameter files once (e.g. by saving the appropriate instrument file as the parameter file) and transmit these onto the other instruments.

Parameter files are ".cfp" format files.

3.1.2 System requirements

Operating system
- Windows® 7
- Windows® 8
- Windows® 10

Computer
The computer must fulfil the requirements of the respective operating system. The following requirements must additionally be fulfilled:
- Interface USB 1.1 or higher
- Graphic resolution min. 1024 x 768

Date and time settings are automatically taken over from the computer. The administrator must ensure that the system time is regularly synchronized with a reliable time source, in order to guarantee the authenticity of the data.

Software
The P2A software must be purchased and installed separately from the transmitter. If it is a new software version, the transmitter is already supported completely. Older P2A software versions can be updated via the P2A software upgrade (cf. product CD included with the transmitter).
3.1.3 Scope of delivery

Included in the scope of delivery are:

- P2A software
- USB driver

When working with the parameterizing, adjusting and analyzing software (P2A software), previous knowledge of Windows® operating systems is assumed.

3.2 First steps

3.2.1 Installing the software/driver

Administrator rights are required for installation.

3.2.1.1 Installing P2A software

1. Insert CD with P2A software.
   
   If the installation program does not start automatically:
   
   Open Windows Explorer and start the file Setup.exe on the software CD.

2. Follow the directions of the installation assistant.

3.2.1.2 Installing USB driver

Before installing the USB driver, please read the separate documentation that is enclosed with the USB driver CD.
3.2.1.3 P2A software upgrade

2. Select folder into which the downloaded Zip file was stored, and unzip the file.
4. Follow instructions from installation assistant.

3.2.2 Starting the software

3.2.2.1 Starting the program

> Click on All Programs (Windows® 7, Windows® 8, Windows® 10) | Testo | P2A- Software.

In Windows® 7 the window User account control is opened when starting the software the first time.

> Click on Accept.

The program window is opened (see chapter 3.3.1).

3.2.2.2 Establishing a connection with the instrument

Multiple instruments can be attached, however only one connection is active at all times.

✓ USB driver is installed (see chapter 3.2.1).

1. Start the P2A software.
2. Connect adapter (supplied with the P2A software) to the service interface of the instrument (see volume 1, chapter 1.2.4).
3. Connect instrument/adapter to the PC via the USB interface.
   The instrument file of the attached instrument is shown in the file list.

3.2.2.3 Activating the connection with the instrument

Click on the desired instrument file.

The selected file is marked in colour and the connection with the instrument is activated.

If a connection with the instrument is established when the program is started, the corresponding instrument file is marked automatically.
## 3.3 Using the software

### 3.3.1 User interface

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open</td>
<td>Shows the Windows dialogue for searching and opening files.</td>
</tr>
<tr>
<td></td>
<td>Save as</td>
<td>Saves the parameters of an instrument or parameter file under a new name.</td>
</tr>
<tr>
<td>Edit</td>
<td>Copy</td>
<td>Copies the parameters of the marked instrument or parameter file in the cache.</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Pastes the parameters from the cache in the marked instrument or parameter file.</td>
</tr>
<tr>
<td>View</td>
<td>Toolbar</td>
<td>Activates/deactivates the toolbar or status bar.</td>
</tr>
<tr>
<td></td>
<td>Status bar</td>
<td></td>
</tr>
</tbody>
</table>
### Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Check instrument connections</td>
<td>Checks the connections to a connected instrument without the instrument having to be activated.</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td>A text file with the most important information on the computer and the software is opened via <strong>Display service data</strong>.</td>
</tr>
<tr>
<td>About</td>
<td></td>
<td>Shows the version number of the P2A software.</td>
</tr>
</tbody>
</table>

2 Toolbar:
Shows the Windows-compliant icons for editing.

3 File list:

<table>
<thead>
<tr>
<th>Icon</th>
<th>File</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Instrument file" /></td>
<td>Instrument file</td>
<td>Connection to the instrument has been established.</td>
</tr>
<tr>
<td><img src="image" alt="Instrument file" /></td>
<td>Instrument file</td>
<td>Connection to the instrument has not been established.</td>
</tr>
<tr>
<td><img src="image" alt="Parameter file" /></td>
<td>Parameter file</td>
<td>&lt;Type&gt; &lt;Serial number&gt; &lt;Date&gt; &lt;Time&gt;.cfp</td>
</tr>
<tr>
<td><img src="image" alt="Parameter file" /></td>
<td>Parameter file</td>
<td>File name can be changed. The name can be selected freely, but it is recommended that you retain the reference to the instrument. Parameter files are always marked red; the parameter values they contain are only forwarded to the instrument after being transmitted to the instrument file.</td>
</tr>
</tbody>
</table>

4 Function buttons:

- **[Change parameterization]** see chapter 3.3.2
- **[Test/analyze transmitter]** see chapter 3.3.3
- **[Adjust transmitter]** see chapter 3.3.4
- **[Transmitter history]** see chapter 3.3.5

**Dialogues on editing and testing the instrument are opened by means of the buttons.**
P2A software - 3.3 Using the software

5 File information:

<table>
<thead>
<tr>
<th>Shown in the window</th>
</tr>
</thead>
<tbody>
<tr>
<td>If an instrument file is selected</td>
</tr>
<tr>
<td>Type, serial number, firmware version of the instrument or probe.</td>
</tr>
<tr>
<td>If a parameter file is selected</td>
</tr>
<tr>
<td>Type, serial number and firmware version of instrument for which the parameter file was created.</td>
</tr>
<tr>
<td>Connection status</td>
</tr>
<tr>
<td>Green = connection is active, Red = connection is inactive.</td>
</tr>
</tbody>
</table>

6 Status bar:
Shows the current status when editing via the menu bar.

3.3.2 Editing instrument/parameter file

3.3.2.1 Changing instrument/parameter file

The desired instrument/parameter file is marked.

1 Click on [Change parameterization].
   The Properties of <Instrument type> <Serial number> dialogue is opened with the Change parameterization register.
   If the parameters were transmitted from other parameter files into the instrument file, a message is shown with which you can transmit the new parameters to the connected instrument using [Yes].
   If the parameters should not be transmitted, click on [No].

2 Change or enter parameters in the corresponding fields.
### Unit/analog output

**Explanation**

All analog outputs are parameterized in this mask.

<table>
<thead>
<tr>
<th>Unit/analog output</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit/analog output (graphic)</strong></td>
<td>Unit: 0 to 1 V/5 V/10 V or 4 to 20 mA. Vertical: Current version of the analog output (cannot be changed). Horizontal: Min./max. scale end points of selected unit. The curve changes in accordance with the entered value of scale minimum and maximum.</td>
</tr>
<tr>
<td><strong>Scale minimum/maximum</strong></td>
<td>The endpoints of the scaling can be selected up to the stored scale minimum and maximum. In the process, scaling can take place beyond the measuring range in order to adjust the analog output to the customer system, see <em>volume 1, chapter 1.2.8.</em></td>
</tr>
</tbody>
</table>
### Field | Explanation
---|---
Unit | Selection of the physical unit. When changing the unit, standard values are set for scale minimum and maximum (see transmitter instruction manual for the scale final values).

**Caution!**
When changing the phys. unit, the relay limit values are set to the assigned default values.

Signal delay (graphic) | Curve changes according to the set signal delay.

Signal delay | Time interval in stages of 1 to 15:
1 = no delay
15 = longest delay.
The signal delay is added to the reaction time of the sensor. The signal delay shows averaging over the time interval of the selected stage in seconds:

**Example**
Stage 10 = average of the readings from the last 10 seconds.

The delay of the signal in relation to the change in the process is also significantly influenced by the selection of the particle filter.
**Relay limit values 1 to 4**

**Explanation**

In this mask, the relays or display alarms are parameterized

Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.

---

**Relay x**

Four relays are available (optional).

**Not used**

Relay is not used.

Hysteresis image and input options are hidden.

**Collective alarm**

A relay can be used as a collective alarm detector in the event that selected messages appear. See below for selection of the messages.

**MIN monitoring**

If switched to ON (NO contact) or OFF (NC contact) under the limit value; in the event of a subsequent exceeding of **limit value** plus **hysteresis**, it is switched to OFF (NO contact) or ON (NC contact).
### Field Explanation

**MAX monitoring**
If switched to ON (NO contact) or OFF (NC contact) above the limit value; in the event of a subsequent undershooting of limit value minus hysteresis, it is switched to OFF (NO contact) or ON (NC contact).

The graphic display in the centre of the screen refers to the relay wiring as a NO contact (ON).

**Hysteresis**
To avoid switching cycles.

**Channel**
Selection of the channel that is to be monitored.

**Limit value**
Values for the limits of the unit selected in Unit/analog output; 1 decimal place.
When changing the phys. unit, the relay limit values are set to the default values.

### Collective alarm Explanation

Selection of the messages (error, etc.) that should result in a collective alarm (OR linkage).

List field with checkboxes
Selection of which messages generated in the transmitter should be signalled as the collective alarm via the corresponding relay.
Basic settings

Explanation

Setting the absolute pressure and selection of the H\textsubscript{2}O\textsubscript{2} evaporation process for the parameter °Ctm.

Absolute pressure

The absolute pressure is included in the calculation of the following units:
- °C\textsubscript{tdA} or °F\textsubscript{tdA}
- g/kg or gr/lb
- ppm/\% vol.

H\textsubscript{2}O\textsubscript{2} process

The calculation of the mixture dewpoint unit °Ctm is dependent upon the type of the evaporation process:
- with passive vaporization: H\textsubscript{2}O\textsubscript{2} solution evaporates (via H\textsubscript{2}O\textsubscript{2} water)
- with active vaporization: H\textsubscript{2}O\textsubscript{2} solution is evaporated over a heated metal plate (with evaporated H\textsubscript{2}O\textsubscript{2})
- Input field: Entering the weight proportion of the liquid H\textsubscript{2}O\textsubscript{2} compared to water in \%.
Display | Explanation
---|---
Setting the display functions (if a display is available on the transmitter).

Continuous display lighting | Display lighting is permanently switched on.
Display lighting when button is pressed (10 seconds) | When a particular button on the instrument is pressed, the display lights up for 10 seconds.
Display brightness (0 to 9) | Setting the brightness between 0 and 9:
0 = dark
9 = light.
Display contrast (0 to 9) | Setting the contrast between 0 and 9:
0 = lower contrast
9 = higher contrast.
Using the software

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display language</td>
<td>Selection of the language.</td>
</tr>
<tr>
<td>New password</td>
<td>The password consists of four numbers, each of which must be between 1 and 9. If the password protection is not to be used, the numerical code &quot;0000&quot; must be entered.</td>
</tr>
<tr>
<td>Adopt new password</td>
<td>Button for confirming the new password.</td>
</tr>
<tr>
<td>Valid password</td>
<td>Display of the current password.</td>
</tr>
</tbody>
</table>

**Self-adjustment**

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Parameterizing of testo 6615 probe, if this is used. (See <em>volume 1, chapter 1.3.3.6 and 2.2.6</em>).</td>
</tr>
</tbody>
</table>

Activate self-adjustment

Perform adjustment of testo 6615 probe (auto-correction). The automatic self-adjustment is switched on, which means the probe performs an offset adjustment every x hours. The frequency is given in hours.
Self-adjustment every

Setting the cycle time in which the self-adjustment is to be performed

In order to receive reliable readings during the calibration or equalization period of the probe, testo recommends the shortest possible cycle time. A longer cycle time can be set in continuous operation.

Start self-adjustment

Start self adjustment at a defined time outside the cycle time.

3 Click on [Apply].

Changes are saved.

3.3.2.2 Saving parameters

Parameters can be saved in new parameter files.

1 Mark instrument/parameter file

2 Click on File > Save as in the menu bar.

3 Select storage location and enter the file name.

4 Click on [Save].

The new parameter file is shown in the file list.

Only the parameters are saved from an instrument file, the history data are not adopted.

The original name (Instrument type, Serial number) is suggested with the current date/time as standard, e.g. "testo 6681 01234578 061120 1403.cfp".

For a standard installation, the files are saved under "C:\Documents and Settings\All Users\Shared Documents\P2A Software". The path can differ depending on the version of the operating system.

3.3.2.3 Open parameter file

All parameter files stored in the standard directory path are automatically displayed in the file list when the software is started.

You can also open parameter files that are stored in other directories.
1. Click on **File > Open** in the menu bar.
2. Select the storage location and click on the requisite file.
3. Click on **[Open]**.

The selected file is opened. This can be changed and saved (see **chapter 3.3.2.2**).

### 3.3.2.4 Copying and pasting parameters

The parameters of a parameter file can be transmitted to an instrument file or another parameter file from the same instrument type.

1. Select file whose parameters are to be copied.
2. Click on **Edit > Copy** in the menu bar.
3. Select the file which is to be modified.
4. Click on **Edit > Paste** in the menu bar.

The parameters are transmitted to the file.

You can also use the common keyboard shortcuts for copying and pasting, i.e. CTRL C and CTRL V.

Parameters can also be transmitted using drag & drop, where you drag the icon of the parameter file onto the icon of the target instrument file.

### 3.3.2.5 Deleting instrument/parameter file

Instrument/parameter files can be deleted from the file list.

1. Click on the file that is to be deleted with the right mouse button.
2. Select the command **Delete** in the context menu.

The instrument or parameter file is deleted from the list.

### 3.3.3 Analyzing/testing the transmitter

In this section, you can test the outputs of the connected instrument, read off the limit values and reset the parameters to the factory settings.

The function is only available for instrument files.

#### 3.3.3.1 Analyzing/testing the instrument

- The required instrument file is marked.
- 1. Click on **[Test/analyze transmitter]**.
The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2 Perform action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carry out factory reset:</td>
<td>Reset the unit, limit value and hysteresis parameters to factory settings (see chapter 3.3.3.2)</td>
</tr>
<tr>
<td>Test analog output:</td>
<td>Test channel 1/2/3 (optional) (see chapter 3.3.3.3).</td>
</tr>
<tr>
<td>Test switch outputs:</td>
<td>Manually switch relays 1 to 4 to test for proper function (see chapter 3.3.3.3).</td>
</tr>
<tr>
<td>Min./max. values display:</td>
<td>Overview of the minimum and maximum values measured since the last reset of the transmitter (see chapter 3.3.3.4).</td>
</tr>
</tbody>
</table>

3 Click on [OK] or [Cancel] to close the dialogue.

3.3.3.2 Carry out factory reset

✓ The required instrument file is marked.

1 Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2 Mark Transmitter test.

Current operating hours are shown.

3 Confirm control query to perform the reset.

The values are reset to the customer-specific factory settings.

4 Click on [OK] or [Cancel] to close the dialogue.

3.3.3.3 Testing channel 1/2/3 analog output

✓ The required instrument file is marked.

1 Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2 Mark channel and test values.
### Field/button | Explanation
---|---
Checking the analog outputs (see *volume 1, chapter 1.4.6.6*).

<table>
<thead>
<tr>
<th>Current reading</th>
<th>Readings are updated every second.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit according to the type of analog output.</td>
</tr>
<tr>
<td>Default value</td>
<td>Freely definable output value for the respective type of analog output (V or mA), 1 decimal place.</td>
</tr>
<tr>
<td>[Activate]</td>
<td>The entered default value is forwarded to the corresponding analog output and to the test contacts by clicking. A warning informs that the value is being transmitted to the connected instrument in the event of existing cabling. Now check the analog output using a precise multimeter.</td>
</tr>
</tbody>
</table>

| [Deactivate]    | Finish entering the electrical variables at the analog output. The analog output returns to the **Current reading** again. |

3. Click on [OK] or [Cancel] to close the dialogue. The analog output returns to Measuring Mode again.
3.3.3.4 Testing switch output relays 1 to 4

✓ The required instrument file is marked.

1 Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2 Mark Relay tests and test the values.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Check the relay function (see volume 1, chapter 1.4.6.6).</td>
</tr>
</tbody>
</table>

[Activate relay n] Close contact.
A warning informs that the value is being transmitted to a connected PLC, external display, etc. in the event of existing cabling.

[Deactivate relay n] Open contact.
A warning informs that the value is being transmitted to a connected PLC, external display, etc. in the event of existing cabling.

3 Click on [OK] or [Cancel] to close the dialogue.
The analog output returns to Measuring Mode again.
3.3.3.5 Displaying min./max. values

The transmitter saves the minimum or maximum value for each channel (measured since the last voltage supply or since the last manual reset).

✓ The required instrument file is marked.

1 Click on [Test/analyze transmitter].

The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2 Mark Min./max. values.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the min./max. values of each channel.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channel</th>
<th>Min./max. of channel 1/2/3 (optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Min. or max. value, 1 decimal place.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit selected in Unit/analog output.</td>
</tr>
</tbody>
</table>
3 Reset **Min./max. values**.

4 Click on [Reset the min./max. values].

5 Confirm control query to perform the reset.
   The values are reset to the default settings.

5 Click on [OK] or [Cancel] to close the dialogue.

### 3.3.4 Adjusting the transmitter

This function is used to adjust an attached instrument. The following adjustments may be carried out using the software:

- 1-point adjustment (offset)
- 2-point adjustment (upper and lower adjustment point)
- Analog adjustment (entry via assistant/wizard).

Also see *volume 1, chapter 1.3.3* for this.

#### 3.3.4.1 1-point adjustment

1 Expose the reference measuring instrument and the instrument to be adjusted to the same constant conditions and wait for equalization period to lapse.

2 Mark the instrument file of the connected instrument.

3 Click on [Adjusting the transmitter].
   The **Properties of <Instrument type> <Serial number>** dialogue is opened with the **Adjusting the transmitter** register.

4 Enter reference value and click on [Carry out 1-point adjustment].

5 Confirm confirmation request
   The adjustment is carried out.
### Field | Explanation
--- | ---
°C/°F | Selection of the unit; only for temperature adjustment.
Current reading | Reading in °C/°F or % RH. Readings are updated every second.
Reference value | Entry of the read-off value from the reference measuring instrument. Permissible entries:
- max. 5 % RH deviation
- max. 2 K (°C) deviation

Click on **[Set offset to zero]** to reset a transmitted reference value. The current reading is used again.

6. Click on **[OK]** or **[Cancel]** to close the dialogue.
3.3.4.2 2-point adjustment

Also see volume 1, chapter 1.3.3.3.

1 Expose the reference measuring instrument and the instrument to be adjusted to the same constant conditions and wait for equalization period to lapse.

2 Mark the instrument file of the connected instrument.

3 Click on [Adjusting the transmitter].

   The Properties of `<Instrument type>` `<Serial number>` dialogue is opened with the Adjusting the transmitter register.

4 Mark 11.3 %, enter the reference value for the lower adjustment point and click on [Lower adjustment point].

   The adjustment is carried out.

5 Mark 75.3 %, enter the reference value for the upper adjustment point and click on [Upper adjustment point].

   The adjustment is carried out.
### Field | Explanation
---|---
Current reading | Reading in % RH. Readings are updated every second.
Reference value | Entry of the read-off value from the reference measuring instrument. Permissible entries:
     | Lower adjustment point 10.3 to 12.3 % RH
     | Upper adjustment point 74.3 to 76.3 % RH.

6. Click on [OK] or [Cancel] to close the dialogue.
3.3.4.3 **Adjusting the analog output**

1. Connect precision multimeter (see *volume 1, chapter 1.3.3.4*).
2. Mark the instrument file of the connected instrument.
3. Click on [**Adjusting the transmitter**].
   The **Properties of <Instrument type> <Serial number>** dialogue is opened with the **Adjusting the transmitter** register.
4. Click on [**Start wizard...**] and follow the instructions of the wizard. The adjustment is performed when the wizard is closed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>The analog output value is given at the output:</td>
</tr>
<tr>
<td></td>
<td>Lower adjustment point: 10 % of the max. value</td>
</tr>
<tr>
<td></td>
<td>Centre adjustment point: 50% of the max. value</td>
</tr>
<tr>
<td></td>
<td>Upper adjustment point: 90 % of the max. value</td>
</tr>
<tr>
<td>Measured analog value</td>
<td>Required field: Entry of the value read off at the multimeter.</td>
</tr>
</tbody>
</table>
3.3.5 Transmitter history

Parameterizations, adjustment processes and messages that have occurred are registered in the transmitter with an operating hours stamp.

In the history overviews (explained later in more detail), past processes and events can be made visible.

For parameter changes or adjustments that are performed directly at the instrument (via the user menu), "Transmitter" is entered in the User field and only the operating hour is entered in the Date/time field instead of operating hour/date/time.

For entries that are performed using the P2A software, the name of the user logged into Windows appears in the User field, while the operating hour is shown in the Date/time field.

1  Mark the instrument file of the connected instrument.
2  Click on [Transmitter history] button.
   The "Properties of <Instrument type> <Serial number>" dialogue is opened with the Transmitter history register.
3  Click on the required entry in the list to change the display.
### Parameterization history

<table>
<thead>
<tr>
<th>Date/time</th>
<th>Format of the PC time is adopted from the settings of the operating system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Name with which the user is logged into the operating system.</td>
</tr>
<tr>
<td></td>
<td>&quot;MUF&quot; (= transmitter) if the change was performed at the instrument.</td>
</tr>
<tr>
<td>Operating hours/date/time</td>
<td>Operating hour/time stamp at which the change at the instrument was performed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Type of parameter change, e.g. &quot;Unit of channel 2 from °F to °C&quot;.</td>
</tr>
</tbody>
</table>
Selection: **1-point adjustments**/**2-point adjustments**/**Analog adjustments**.

**Date/time**
Format of the PC time is adopted from the settings of the operating system.

**User**
Name with which the user is logged into the operating system.
"MUF" (= transmitter) if the change was performed at the instrument.

**Operating hours/date/time**
Operating hour/time stamp at which the change at the instrument was performed.

**Serial no. Probe**
Serial number of the probe.

**Reference value**
If no changes were performed, no value is displayed.
<table>
<thead>
<tr>
<th>Column</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit during the adjustment.</td>
</tr>
<tr>
<td>Actual value before adjustment</td>
<td>1-point adjustment: If no changes were performed, no value is displayed.</td>
</tr>
<tr>
<td>Offset from</td>
<td>1-point adjustment: Value before the adjustment.</td>
</tr>
<tr>
<td>Offset to</td>
<td>1-point adjustment: Value after the adjustment.</td>
</tr>
<tr>
<td>Offset</td>
<td>2-point adjustment: Difference between target and actual value reported by instrument.</td>
</tr>
<tr>
<td>Channel</td>
<td>Analog adjustment: Channel 1 to n.</td>
</tr>
<tr>
<td>Specification</td>
<td>Analog adjustment: Actual value.</td>
</tr>
<tr>
<td>Reading</td>
<td>Analog adjustment: Reference value entered.</td>
</tr>
<tr>
<td>Offset</td>
<td>Analog adjustment: Deviation at time of adjustment.</td>
</tr>
</tbody>
</table>
The table is shown only for error and status messages that were generated in the transmitter and were transferred and saved there via the connection to the P2A software.

**Date/time**
Format of the PC time is adopted from the settings of the operating system.

**Operating hours**
Operating hour at which the message appeared in the instrument.

**User**
"MUF" (= transmitter) because the message was generated in the transmitter.

**Message**
e.g. "Wrong probe". A non-compatible probe was connected.

**Type of message**
e.g. early warning, status message.

To print out the history data, click on [Print].
The printing job is automatically sent to the default printer for the operating system.

The printout can be edited using [Set up printer…].

4 Click on [OK] or [Cancel] to close the dialogue.
4 Tips and assistance

4.1 Questions and answers

<table>
<thead>
<tr>
<th>Question</th>
<th>Possible causes/solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection to instrument cannot be established</td>
<td>Check connection cable/plug contacts</td>
</tr>
<tr>
<td>A message appears on the display</td>
<td>See volume 1, chapter 1.5.</td>
</tr>
<tr>
<td>Malfunction (with or without display)</td>
<td>Analysis using the P2A software, see chapter 3.3.</td>
</tr>
</tbody>
</table>
| Undo adjustment                                               | A 1-point temperature/humidity adjustment can be reset to the current reading using [Set offset to zero].  
The actual values before the adjustment can be read out from the corresponding history table.  
2-point adjustments and analog adjustments can only be undone by means of a factory reset. |
| When does a stable current reading appear?                    | After approx. 20 seconds                                                                  |

If we could not answer your question, please contact your dealer or Testo Customer Service. For contact data, see back of this document or web page www.testo.com/service-contact.
## 4.2 Accessories and spare parts

An overview of the probes that can be used with the testo 6681 can be found in *volume 1, chapter 1.2.2.*

<table>
<thead>
<tr>
<th>Designation</th>
<th>Article no.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interface and software</strong></td>
<td></td>
</tr>
<tr>
<td>P2A software (parameterizing, adjusting, analyzing) incl. USB adapter</td>
<td>0554 6020</td>
</tr>
<tr>
<td><strong>Fastenings, assembly aids</strong></td>
<td></td>
</tr>
<tr>
<td>Wall/duct bracket with M3 screw for fastening the transmitter to the probe and the probe to the wall/duct</td>
<td>0554 6651</td>
</tr>
<tr>
<td>Pressure-tight G 1/2&quot; screw connection with cutting ring up to 16 bar</td>
<td>0554 1795</td>
</tr>
<tr>
<td>Pressure-tight G 1/2&quot; screw connection with PTFE ring up to 6 bar</td>
<td>0554 1796</td>
</tr>
<tr>
<td><strong>Plug-in connections</strong></td>
<td></td>
</tr>
<tr>
<td>Set of M12 plug-in connections (connector and socket) for power and signal lines</td>
<td>0554 6682</td>
</tr>
</tbody>
</table>
### 4.2 Accessories and spare parts

<table>
<thead>
<tr>
<th>Designation</th>
<th>Article no.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dewpoint measurement</strong> (only with testo 6615)</td>
<td></td>
</tr>
<tr>
<td>Pre-filter for the protection of the measurement chamber and sensor</td>
<td>0554 3311</td>
</tr>
<tr>
<td>from contamination</td>
<td></td>
</tr>
<tr>
<td>Precision chamber for adjustable flow impact</td>
<td>0554 3312</td>
</tr>
<tr>
<td><strong>Sensor filters and protective caps</strong></td>
<td></td>
</tr>
<tr>
<td>Stainless steel sintered filter</td>
<td>0554 0647</td>
</tr>
<tr>
<td>Wire mesh filter</td>
<td>0554 0757</td>
</tr>
<tr>
<td>Sintered PTFE filter</td>
<td>0554 0759</td>
</tr>
<tr>
<td>Protection cap made of metal (open)</td>
<td>0554 0755</td>
</tr>
<tr>
<td>PTFE protection cap with drip hole</td>
<td>0554 9913</td>
</tr>
<tr>
<td>Condensation protector</td>
<td>0554 0166</td>
</tr>
<tr>
<td>Filter for H2O2 atmospheres</td>
<td>0554 6000</td>
</tr>
<tr>
<td>H2O2 protection cap</td>
<td>0699 5867/1</td>
</tr>
<tr>
<td><strong>Adjustment equipment</strong></td>
<td></td>
</tr>
<tr>
<td>Humidity adjustment set (11.3/75.3 % RH)</td>
<td>0554 0660</td>
</tr>
<tr>
<td>Extension and adjustment cable</td>
<td>0554 6610</td>
</tr>
<tr>
<td><strong>Supply</strong></td>
<td></td>
</tr>
<tr>
<td>Mains unit (desktop, wall-mounted)</td>
<td>0554 1748</td>
</tr>
<tr>
<td>Mains unit (top-hat rail mounting)</td>
<td>0554 1749</td>
</tr>
<tr>
<td><strong>Calibration</strong></td>
<td></td>
</tr>
<tr>
<td>Standard ISO calibration certificate, transmitter + probes</td>
<td>0520 0176</td>
</tr>
<tr>
<td>Special ISO calibration certificate, transmitter + probes</td>
<td>0520 0066</td>
</tr>
<tr>
<td>Standard DAkkS calibration certificate, transmitter + probes</td>
<td>0520 0276</td>
</tr>
<tr>
<td>Special DAkkS calibration certificate, transmitter + probes</td>
<td>0520 0236</td>
</tr>
<tr>
<td>ISO- calibration certificate humidity, probes</td>
<td>0520 0076</td>
</tr>
<tr>
<td>DAkkS calibration certificate temperature, probes</td>
<td>0520 0261</td>
</tr>
</tbody>
</table>
## 4.2.1 Ordering options for testo 6681 transmitter
(0555 6681)

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axx</strong></td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>A01</td>
<td>Currently no further selection of variants</td>
</tr>
<tr>
<td><strong>Bxx</strong></td>
<td>Analog output</td>
</tr>
<tr>
<td>B02</td>
<td>0 to 1 V (4-wire, 24 VAC/DC)</td>
</tr>
<tr>
<td>B03</td>
<td>0 to 5 V (4-wire, 24 VAC/DC)</td>
</tr>
<tr>
<td>B04</td>
<td>0 to 10 V (4-wire, 24 VAC/DC)</td>
</tr>
<tr>
<td>B05</td>
<td>0 to 20 mA (4-wire, 24 VAC/DC)</td>
</tr>
<tr>
<td>B06</td>
<td>4 to 20 mA (4-wire, 24 VAC/DC)</td>
</tr>
<tr>
<td><strong>Cxx</strong></td>
<td>Display</td>
</tr>
<tr>
<td>C00</td>
<td>without display</td>
</tr>
<tr>
<td>C02</td>
<td>with display/English</td>
</tr>
<tr>
<td>C03</td>
<td>with display/German</td>
</tr>
<tr>
<td>C04</td>
<td>with display/French</td>
</tr>
<tr>
<td>C05</td>
<td>with display/Spanish</td>
</tr>
<tr>
<td>C06</td>
<td>with display/Italian</td>
</tr>
<tr>
<td>C07</td>
<td>with display/Japanese</td>
</tr>
<tr>
<td><strong>Dxx</strong></td>
<td>Cable entry</td>
</tr>
<tr>
<td>D01</td>
<td>M16 PG screw connection (with relay, also M20)</td>
</tr>
<tr>
<td>D02</td>
<td>Cable entry NPT 1/2&quot;</td>
</tr>
<tr>
<td>D03</td>
<td>Plug-in connections for power and signal lines</td>
</tr>
<tr>
<td><strong>Fxx</strong></td>
<td>Channel 1 Unit</td>
</tr>
<tr>
<td>F01</td>
<td>% RH/Min/Max</td>
</tr>
<tr>
<td>F02</td>
<td>°C/Min/Max</td>
</tr>
<tr>
<td>F03</td>
<td>°F/Min/Max</td>
</tr>
<tr>
<td>F04</td>
<td>°Ctd/Min/Max</td>
</tr>
<tr>
<td>F05</td>
<td>°Ftd/Min/Max</td>
</tr>
<tr>
<td>F06</td>
<td>g/kg /Min/Max</td>
</tr>
<tr>
<td>F07</td>
<td>gr/lb /Min/Max</td>
</tr>
</tbody>
</table>
### 4.2 Accessories and spare parts

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>F08</td>
<td>g/m³/Min/Max</td>
</tr>
<tr>
<td>F09</td>
<td>gr/ft³/Min/Max</td>
</tr>
<tr>
<td>F10</td>
<td>ppm&lt;sub&gt;vol&lt;/sub&gt;/min/max</td>
</tr>
<tr>
<td>F11</td>
<td>°C&lt;sub&gt;wb&lt;/sub&gt;/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>F12</td>
<td>°F&lt;sub&gt;wb&lt;/sub&gt;/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>F13</td>
<td>kJ/kg/Min/Max (enthalpy)</td>
</tr>
<tr>
<td>F14</td>
<td>hPa/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>F15</td>
<td>inch H2O/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>F18</td>
<td>% Vol/min/max</td>
</tr>
</tbody>
</table>

**Gxx**

**Channel 2 Unit**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>G01</td>
<td>% RH/Min/Max</td>
</tr>
<tr>
<td>G02</td>
<td>°C/Min/Max</td>
</tr>
<tr>
<td>G03</td>
<td>°F/Min/Max</td>
</tr>
<tr>
<td>G04</td>
<td>°Ctd/Min/Max</td>
</tr>
<tr>
<td>G05</td>
<td>°Ftd/Min/Max</td>
</tr>
<tr>
<td>G06</td>
<td>g/kg/Min/Max</td>
</tr>
<tr>
<td>G07</td>
<td>gr/lb/Min/Max</td>
</tr>
<tr>
<td>G08</td>
<td>g/m³/Min/Max</td>
</tr>
<tr>
<td>G09</td>
<td>gr/ft³/Min/Max</td>
</tr>
<tr>
<td>G10</td>
<td>ppm&lt;sub&gt;vol&lt;/sub&gt;/min/max</td>
</tr>
<tr>
<td>G11</td>
<td>°C&lt;sub&gt;wb&lt;/sub&gt;/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>G12</td>
<td>°F&lt;sub&gt;wb&lt;/sub&gt;/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>G13</td>
<td>kJ/kg/Min/Max (enthalpy)</td>
</tr>
<tr>
<td>G14</td>
<td>hPa/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>G15</td>
<td>inch H2O/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>G18</td>
<td>% Vol/min/max</td>
</tr>
</tbody>
</table>

**Hxx**

**Relay**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>H00</td>
<td>without relay</td>
</tr>
<tr>
<td>H01</td>
<td>4 relay outputs, limit value monitoring</td>
</tr>
<tr>
<td>H02</td>
<td>4 relay outputs, channel 1 limit values and collective alarm</td>
</tr>
</tbody>
</table>
## 4.2 Accessories and spare parts

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ixx</td>
<td>Optional 3rd analog output</td>
</tr>
<tr>
<td>I00</td>
<td>no optional 3rd analog output</td>
</tr>
<tr>
<td>I01</td>
<td>% RH/Min/Max</td>
</tr>
<tr>
<td>I02</td>
<td>°C/Min/Max</td>
</tr>
<tr>
<td>I03</td>
<td>°F/Min/Max</td>
</tr>
<tr>
<td>I04</td>
<td>°Ctd/Min/Max</td>
</tr>
<tr>
<td>I05</td>
<td>°Ftd/Min/Max</td>
</tr>
<tr>
<td>I06</td>
<td>g/kg /Min/Max</td>
</tr>
<tr>
<td>I07</td>
<td>gr/lb /Min/Max</td>
</tr>
<tr>
<td>I08</td>
<td>g/m³/Min/Max</td>
</tr>
<tr>
<td>I09</td>
<td>gr/ft³/Min/Max</td>
</tr>
<tr>
<td>I10</td>
<td>ppmVol/min/max</td>
</tr>
<tr>
<td>I11</td>
<td>°Cwb/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>I12</td>
<td>°Fwb/Min/Max (wet bulb)</td>
</tr>
<tr>
<td>I13</td>
<td>kJ/kg /Min/Max (enthalpy)</td>
</tr>
<tr>
<td>I14</td>
<td>hPa /Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>I15</td>
<td>inch H2O/Min/Max (water vapour partial pressure)</td>
</tr>
<tr>
<td>I16</td>
<td>°Ctm (H2O₂ mixture dewpoint)</td>
</tr>
<tr>
<td>I17</td>
<td>°Ftm (H2O₂ mixture dewpoint)</td>
</tr>
<tr>
<td>I18</td>
<td>% Vol / min / max</td>
</tr>
<tr>
<td>I19</td>
<td>%RHm (mixture humidity for H₂O₂)</td>
</tr>
</tbody>
</table>
### 4.2.2 Ordering options for testo 6610 probes (0555 6610)

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lxx</strong></td>
<td><strong>Probe type</strong></td>
</tr>
<tr>
<td>L 11</td>
<td>Probe 6611</td>
</tr>
<tr>
<td>L 12</td>
<td>Probe 6612</td>
</tr>
<tr>
<td>L 13</td>
<td>Probe 6613</td>
</tr>
<tr>
<td>L 14</td>
<td>Probe 6614</td>
</tr>
<tr>
<td>L 15</td>
<td>Probe 6615</td>
</tr>
<tr>
<td>L 17</td>
<td>Probe 6617</td>
</tr>
<tr>
<td><strong>Mxx</strong></td>
<td><strong>Protective filter</strong></td>
</tr>
<tr>
<td>M 01</td>
<td>Stainless steel sintered filter</td>
</tr>
<tr>
<td>M 02</td>
<td>Metal wire protection cap</td>
</tr>
<tr>
<td>M 03</td>
<td>Sintered PTFE filter</td>
</tr>
<tr>
<td>M 04</td>
<td>Open metal protection cap</td>
</tr>
<tr>
<td>M 06</td>
<td>PTFE filter with drip hole</td>
</tr>
<tr>
<td>M 07</td>
<td>PTFE filter with drip hole and condensation protector</td>
</tr>
<tr>
<td>M 08</td>
<td>Filter for H2O2 atmospheres</td>
</tr>
<tr>
<td><strong>Nxx</strong></td>
<td><strong>Cable length</strong></td>
</tr>
<tr>
<td>N 00</td>
<td>Without cable (testo 6611)</td>
</tr>
<tr>
<td>N 01</td>
<td>1 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 02</td>
<td>2 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 05</td>
<td>5 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 10</td>
<td>10 m cable length (testo 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>N 23</td>
<td>Cable length specifically for duct versions (testo 6612)</td>
</tr>
<tr>
<td><strong>Pxx</strong></td>
<td><strong>Probe length</strong></td>
</tr>
<tr>
<td>P 07</td>
<td>Probe length approx. 70 mm (testo 6611)</td>
</tr>
<tr>
<td>P 12</td>
<td>Probe length approx. 120 mm (testo 6613)</td>
</tr>
<tr>
<td>P 20</td>
<td>Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>P 30</td>
<td>Probe length approx. 300 mm (testo 6612, 6613, 6614)</td>
</tr>
<tr>
<td>Order code</td>
<td>Characteristic</td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>P 50</td>
<td>Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615, 6617)</td>
</tr>
<tr>
<td>P 80</td>
<td>Probe length approx. 800 mm (testo 6612, 6613)</td>
</tr>
</tbody>
</table>